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I n t r o d u c t i o n

I N T R O D U C T I O N

The system MAGIC AE1 DAB is implemented as DAB Audio Encoder and has ana-
logue and digital AES/EBU audio interfaces. For monitoring each system contains
an own decoder which allows a control of the system and to asses the audio qual-
ity.

The ISO/MPEG2 Layer II audio encoder is an implementation of the IRT (Institut
für Rundfunktechnik) in Munich.

The configuration of the system can be carried out via the Windows application
included in delivery or via the front keypad and display of the unit.

English
Deutsch
Menu
Select
Back
Basic Settings
Basic Settings
Language
Language
Cap
Ok
Save settings?
Yes
No
Operation Settings
Select
Mode
ISDN
Analogue POTS
Audio
Audio Settings
Audio Settings
Audio input
Audio output
Analogue
Digital
PRETALK Interface
No system
Telephone
Handset
Delete
Opt.
ON AIR
HOLD
PRETALK
Dialling...
Callin
Beendet
Line
Ringing Tone
Search
Names
New Entry
Edit
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I n t r o d u c t i o n

Display
Delete entry
Save as Quick Dial
Presets
Load
New
Save
Delete Preset
Ringing Tone
Signal Processing
Keypad 9600, none
Status information
Login
Shift
Mon.
Cod
Org
MPEG Parameter
Max Mono Rate
Max LSF Rate
Mono Mode
Mono L+R/2
Mono Left
Mono Right
Stereo Mode
Stereo
Joint Stereo
Dual Channel
PAD Interface
Activate PAD
Active
Baudrate
38400
57600
115200



PAGE 13

S a f e t y

S A F E T Y

Introduction

The unit described has been designed to the latest technical parameters and
complies with all current national and international safety requirements. It oper-
ates on a high level of reliability because of long-term experience in development
and constant and strict quality control in our company.

In normal operation the unit is safe.

However, some potential sources of danger for person, material and optimal op-
eration remain - especially if daily routine and technical errors coincide.

This manual therefore contains basic safety instructions that must be observed
during configuration and operation. It is essential that the user reads this manual
before the system is used and that a current version of the manual is always kept
close to the equipment.

General safety requirements

To keep the technically unavoidable residual risk to a minimum, it is absolutely
necessary to observe the following rules:

– Transport, storage and operation of the unit must be under the permissible 
conditions only. 

– Installation, configuration and disassembly must be carried out only by trained 
personnel on the basis of the respective manual.

– The unit must be operated by competent and authorised users only.

– The unit must be operated in good working order only.

– Any conversions or alterations to the unit or to parts of the unit (including soft-
ware) must be carried out by trained personnel authorised by the manufac-
turer. Any conversions or alterations carried out by other persons lead to a 
complete exemption of liability.

– Only specially qualified personnel is authorised to remove or override safety 
measures, and to carry out the maintenance of the system.

– External software is used at one’s one risk. Use of external software can affect 
the operation of the system.

– Use only tested and virus-free data carriers.
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S i c h e r h e i t

Text Conventions

In this manual the following conventions are used as text markers:

Accentuation: Product names or important terms

LCD Text: Labelling on the front display of the system

PC Text: Labelling in the PC Software

TIP The symbol TIP marks information which facilitates the operation of the system in
its daily use.

NOTICE The symbol NOTICE marks general notes to observe.

ATTENTION The symbol ATTENTION marks very important advice that is absolutely to observe.
In case of non-observance disfunctions and even system errors are possible.

!
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1 C O N S T R U C T I O N

The functions of the MAGIC AE1 DAB are implemented in a single unit. The system
is additionally equipped with a module for MPEG Coding. The system is designed
for mounting in a 19" rack (1 U). 19“ brackets are part of the delivery.

FIG. 1 FRONT VIEW: MAGIC AE1 DAB DAB AUDIO ENCODER
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2 S Y S T E M  D E S C R I P T I O N

The functional elements of the system are pictured in Fig. 2.

FIG. 2 FUNCTIONAL ELEMENTS OF MAGIC AE1 DAB DAB AUDIO ENCODER

2.1 Functionality

The MAGIC AE1 DAB System incorporates a X.21 interface1 for a direct connec-
tion to the e.g. DM-001 Ensemble Multiplexer from Rohde & Schwarz. The X.21
clock is derived from the Ensemble Multiplexer clock.

The complete signal processing is taken over by two digital signal processors. In
this way the following functions are realised:

DSP1:

– ISO/MPEG2 Layer II Decoder

– digital audio router

– Signalling management 

– Control of the complete system (Keypad, display, relays, TTL, RS232)

– PAD multiplexer

1 The LAN interface for control & management will be supported in a later release.
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DSP2:

– ISO/MPEG2 Layer II Encoder

Via the main audio channel the high quality Stereo or Mono audio signal is in-
serted analogue or digitally. If the digital AES/EBU audio interface is used, two
separate Sample Rate Converters are available for automatic clock synchronisa-
tion between network and audio source. For external clocking a clock input and a
clock output are available.

The audio outputs can be used for monitoring purposes. The encoded signal is
looped at every time to the MPEG decoder. The decoded audio signal is available
as analogue or digital audio output. As second audio monitoring interface a head-
phone interface is available.

The configuration and operation can be primarily carried out via the front keypad
and the illuminated display.

Configuration and control is especially comfortable with the MAGIC AE1 DAB Win-
dows PC Software which is included in delivery and which communicates with the
system via the RS232 interface1.

Six programmable TTL contacts can be used for external signalling. Two relays are
available for status indication.

1 LAN control is planned.
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3 P U T T I N G  T H E  S Y S T E M  I N T O  O P E R A T I O N

3.1 Mounting

With its dimensions (W × H × D) of 431 mm × 44,5 mm (1 U) × 250 mm the
MAGIC AE1 DAB system can be used either as desktop device or mounted in 19
inch racks. Corresponding 19“ mounting brackets are included in delivery.

When mounting the unit please keep in mind that the bending radius of the cables
is always greater than the minimum allowed value. 

When the MAGIC AE1 DAB audio encoder is installed, please make sure that
there is sufficient ventilation: It is recommended to keep a spacing of ca. 3 cm
from the openings. In general, the ambient temperature of the system should be
within the range of +5°C and +45°C. These thresholds are especially to observe
if the system is inserted in a rack. The system works without ventilation.

During operation air humidity must range between 5% and 85%. 

3.2 Connection to the mains voltage

The system can be operated with mains voltages in the range from 90 V to 253 V.
The frequency can vary from 45 Hz to 65 Hz. The maximum power consumption
is 15W (typically 12W).

After plugging the mains connector and switching on the system boots within a
few seconds. In standby mode the MAGIC AE1 DAB logo is shown on the display.

3.3 Earthing of the system

For EMC reasons an earthing via the earthing screw of the system is recom-
mended.

TIP The system temperature can be indicated on the display (Menu Status informa-
tion (see CHAPTER A1.4, Page 63))

ATTENTION Incorrect ambient temperature and humidity can cause functional deficiencies
Operation outside the threshold values indicated above leads to a loss of war-
ranty claim.

ATTENTION Earthing
A lacking earthing can cause functional deficiencies within the unit.

!

!
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3.4 Operational elements on the front side

The system has an illuminated graphical display with a resolution of 160 x 32 Pix-
els and 19 operating buttons.

On the right next to the display there are two softkeys whose current functions are
indicated on the display. In the middle there are two buttons for navigation (
and ), two buttons for establishing ( )/dropping ( ) connections as well
as an OK button. The numerical pad supports in addition to the numerics 0...9 the
’*’ and ’#’ key. For text entries the numerical pad can also be used as normal key-
pad.

The operation is similar to standard mobile telephones.

FIG. 3 OPERATIONAL ELEMENTS ON THE FRONT SIDE

Softkeys Navigation
buttons/

Establish connection

Drop connection/
Main menu

Keypad for 
 text entry

Display
shift

Confirm entry

Graphical
display

Status window

Headphone
Level
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3.5 Wiring diagram

The figure below show the typical wiring diagram of a DAB system.

FIG. 4 WIRING DIAGRAM

The standard interfacing of the system is shown Fig. 5.

FIG. 5 WIRING & CONNECTION DIAGRAM

Mains

RS232
PC

RS232
PAD

X.21
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Audio Input
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4 O P E R A T I O N  V I A  D I S P L A Y  A N D  K E Y P A D

In this chapter all basic configurations for the operation of the MAGIC AE1 DAB
system are explained. An overview of the menu structure you will find in the annex
under CHAPTER A1.

Of course, all configurations can also be comfortably made via the MAGIC AE1
DAB Software included in delivery.

4.1 Standard functions

Keypad lock

To avoid that keys are pressed accidentally you can enable a keypad lock. For ac-
tivation please press the Menu key followed by the * (star) button. If the keypad
lock is enabled the display illumination is turned off immediately.

The keypad lock is deactivated by entering the key sequence Menu * a second
time.

Softkey Menu

Using the softkey Menu you can change all parameters of the system at any time.
The menu structure is given in CHAPTER A1.1 ... CHAPTER A1.5 (see Page 60).

4.2 Basic configurations

In the following some specific basic configurations of MAGIC AE1 DAB are de-
scribed in detail.

NOTICE For the details of most functions please see the PC Software description from
CHAPTER 5.

NOTICE All menus can be reached directly via a QuickMenu key sequence. For this pur-
pose each menu item is marked with a cypher in the upper left corner (in the ex-
ample on the left it is e. g. 3). To reach a certain menu directly please enter from
the main menu the key sequence Menu <DIGIT> <DIGIT> whereby <digit> marks
the respective menu reference number. Please notice that the menu reference
number can change depending on the configuration.

Menu reference number
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4.2.1 Setting the Audio interface: Analogue or digital

MAGIC AE1 DAB incorporates analogue as well as digital Audio interfaces which
you can adjust separately. The digital AES/EBU interfaces have integrated Sam-
ple Rate Converters to adjust the digital Audio source to the transmission clock.
Additionally, clock inputs/outputs are also available. To configure the Audio inter-
face please follow the instructions below:

– First press the softkey  Menu and select Basic Settings via the softkey  
Select.

– With the use of the Select softkey you reach the option Audio Settings.

– Please mark the option Audio input or Audio output using the cursor keys  
and  and press again Select. Now the options Analogue and Digital are 
displayed. 

– Select the desired interface with the help of the cursor keys  and  and 
by pressing the softkey Select.

– Confirm your entry by pressing the  button or the softkey Ok.

– To get back to the main menu please press the  button. Now you are 
asked if you want to Save settings?. Via the softkey Yes the setting is stored 
permanently in the system.

4.2.2 Configuring of the ISO/MPEG Encoder

All settings of the encoder behaviour can be configured under the menu MPEG Pa-
rameter. For more information please refer to CHAPTER 5.5.2.1.1, Page 34.

– First press the softkey  Menu and select Operation Settings via the softkey 
 Select.

– With the use of the Select softkey you reach the option MPEG Parameter.

– Please mark the option Max Mono Rate using the cursor keys  and  and 
press again Select. Now the desired maximum Mono data rate can be set.

– Confirm the selection with Select and press Ok.

– Select now Max LSF Rate to configure the maximum data rate using the Low 
Sampling Frequency (LSF)1 option. If you don’t want to use LSF select the low-
est possible data rate.

– Confirm the selection with Select and press Ok.

NOTICE If you are not in the main menu please press the  button first.

TIP You reach the settings for the Audio input or Audio output via the key sequence:
Menu 1 1 1 or Menu 1 1 2

NOTICE If you are not in the main menu please press the  button first.

1 Using LSF (24-kHz) increases the audio quality especially for lower bitrates. We recommend to use LSF 
for data rates lower than 64-kbit/s.
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– To configure the desired Mono mode select the menu Mono Mode. Three pos-
sibilities are available: Mono L+R/2, Mono Left, Mono Right.

– Confirm the selection with Select and press Ok.

– Please mark now the option Stereo Mode and select the desired Stereo mode: 
Stereo, Joint Stereo, Dual Channel.

– Confirm the selection with Select and press Ok.

– To get back to the main menu please press the  button. Now you are 
asked if you want to Save settings?. Via the softkey Yes the setting is stored 
permanently in the system.

4.2.3 Activating and configuring the PAD interface

To enable the transmission of PAD you must activate the PAD mode and configure
the right baudrate. For more information please refer to CHAPTER 5.5.2.1.2, Page
36.

– First press the softkey  Menu and select Operation Settings via the softkey 
 Select.

– With the use of the Select softkey you reach the option PAD Interface.

– Please mark the option Activate PAD using the cursor keys  and  and 
press again Select. Now the option Active can be set to activate the PAD in-
terface. 

– Press the softkey  Back and select then Baudrate. After pressing the 
softkey Select you can configure the desired baudrate (38400, 57600, 115200), 
which must be consistent to your PAD inserter.

– Confirm the selected baudrate with Select.

– Select the desired interface with the help of the cursor keys  and  and 
by pressing the softkey Select.

– Confirm your entry by pressing the  button or the softkey Back.

– To get back to the main menu please press the  button. Now you are 
asked if you want to Save settings?. Via the softkey Yes the setting is stored 
permanently in the system.

TIP You reach the settings for the MPEG Parameter via the key sequence: Menu 2 1.

NOTICE If you are not in the main menu please press the  button first.

TIP You reach the settings for the PAD Interface via the key sequence: Menu 2 2.
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4.3 The Status Display - Operation during a connection

When the connection is established the level meter as well as the status for the
selected monitoring signal is displayed.

In the first row the program name, audio bitrate, coding mode (M=Mono,
S=Stereo, D=Dual Channel, J=Joint Stereo) and PAD bitrate (in kbit/s) is shown.

Softkey Monitor (Mon.)

During a connection you can switch via the softkey Mon. between original audio
signal which is feed into the encoder and the decoded audio signal. Both the au-
dio output (XLR) and the headphone will be switched to the selected audio signal.
The display shows the monitoring status as follows:

– Org, if you monitor the audio input signal

– Cod, if you monitor the coded audio signal

Softkey Menu

Using the softkey Menu you can change all parameters of the system at any time.

Headphone Level

If a connection is established you can adjust the headphone level with the navi-
gation buttons  and . The current selected level will be shown in the display.

Dropping a connection

The connection is dropped by pressing the telephone receiver button . If no
connection exists, the main menu is displayed after a few seconds. To avoid errors
you must confirm the drop request.

Establishing a connection

The connection is normally establishing automatically if a clock is available on the
X.21 line interface. After dropping a connection manually you can reconnect the
line by pressing the telephone receiver button .

TIP The status window can always be reached by pressing the  button.

Monitor Mode: Original or Coded
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4.4 Working with Presets

The MAGIC AE1 DAB differentiates between Basic Settings and Operation Set-
tings.

Basic Settings are settings that do not change during normal operation like e.g.
display contrast, date/time etc. These parameters cannot be saved as preset
since a configuration is usually only required when the system is put into opera-
tion.

Operation Settings need to be reconfigured depending on the application. To eas-
ily recall recurring configurations you can store up to 10 presets in the system.

You reach the menu for the Presets by pressing the Menu softkey once, the cursor
key  twice and by pressing the softkey Select once as confirmation.

In the input field Presets you can search for a certain Preset. As soon as you enter
a character, the corresponding entries of the Preset list are filtered out.

Alternatively, you can select a Preset from the list using the cursor keys  and
.

If you now press the  button, the selected Preset is loaded immediately.

By the softkey Opt. (Options) the following functions which you can select via the
softkey Select are realised:

– Load: The stored Preset is loaded.

– New: With the help of this function you can create a new Preset. All current Op-
eration Settings are stored.

– Save: The currently selected Preset is overwritten with the current Operation 
Settings. For safety reasons a confirmation is required.

– Delete Preset: The currently selected Preset is deleted. For safety reasons a 
confirmation is required.

NOTICE If the configuration has changed, you are asked if you want to Save settings?
when you leave the Preset menu. Via the Yes softkey the configuration is stored
permanently in the system. This Preset is loaded automatically by the system af-
ter the unit is connected to the power supply.
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5 W I N D O W S  P C  S O F T W A R E

The configuration of the system is particularly comfortable via the Windows PC
Software included in delivery.

5.1 Hardware requirements

The PC must meet the following minimum requirements:

– IBM PC AT, IBM PS/2 or 100% compatible

– Pentium Prozessor (> 1 GHz) recommended

– Windows 2000/XP

– ca. 600 kByte available RAM

– 5 MB available hard disk space

– Screen resolution with 800 x 600 Pixels

– at least one available serial interface RS-232

– Microsoft, IBM PS/2 or 100% software compatible mouse

5.2 Installing the Windows PC Software

Please insert the CD included in delivery in your CD-ROM drive. The software au-
tomatically starts your Internet browser. Possible safety warnings can be ignored
for the moment. Please press under Install Software the MAGIC AE1 DAB but-
ton. Subsequently, the setup program is executed. 

Alternatively, you can install the software directly from the CD. You will find the in-
stallation file setup.exe in the folder Software\MAGIC AE1 DAB on the CD.

Please follow the instructions of the installation routine.

After the installation the software can be started by clicking on the MAGIC AE1
DAB icon.

Please connect your PC via a serial 1:1 cable (only Pin 2 and Pin 3 are used, Pin
5=ground) with the system.

The standard COM-Port settings are: 38400 Baud

Operation via Windows PC software

In the following chapters all functions of the PC software are described in detail.
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5.3 MAGIC AE1 DAB main window

After starting the MAGIC AE1 DAB application, the main window is displayed au-
tomatically (see Fig. 6). 

The connection status between PC and system is displayed in the top right corner
of the window:

PC ONLINE: Connection is okay.

NO CONNECTION: Connection with PC is faulty

Following further status messages are possible:

PC ONLINE ALARM: Upcoming alarm (see System Monitor, green-dark green
blinking)

FIG. 6 MAIN WINDOW OF THE MAGIC AE1 DAB DAB AUDIO ENCODER SOFTWARE

NOTICE If the connection is faulty, please check the following points:
– External power supply of the system is plugged in (display available)
– Serial 1:1 cable is connected with PC and system
– Correct COM port and same baud rate are selected in the software as well as 

in the system (Configuration → COM Port, see Page 49)

Menu bar

Program name/
Changing of

encoder parameters

Encoder status

Monitoring Decoder
status

Select headphone
monitor source

Output

Select headphone
monitor source

Input

Level meter
Headphone

Headphone
volume control

PC
status

(double-
click

to open
System
Monitor)

Level meter
Encoder/
Decoder

Connect/Disconnect
Line Connection
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5.3.1 Operating elements

Program button

On the Program button the information about the current program is shown. The
program name can be configured via Configuration → Basic settings →
General → Program Name (see Page 38).

By pressing the button it is possible to change the encoder parameter on the fly.

Connect/Disconnect button

To stop the transmission you can press the Disconnect button. For security rea-
sons you must confirm ....

Monitoring Input/Output

Via the Monitoring Input and Output buttons you can select the source for the
headphone. The currently selected source is highlighted in green.

To adjust the headphone level use the Headphone Volume Control, which al-
lows an adjustment in a of range of -40 ... 0 dB.
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5.4 Menu file

FIG. 7 MENU FILE

5.4.1 Operation Settings Presets

To Import/Export the different presets please use the submenu Operation
Settings Presets. The file format is binary and cannot be edited.

5.4.2 Basic Settings

To Import/Export the system configuration please use the submenu Basic Set-
tings. The file format is binary and cannot be edited.

5.4.3 Submenu Exit

Via the submenu Exit you exit the MAGIC AE1 DAB software.
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5.5 Menu Configuration

FIG. 8 MENU CONFIGURATION

5.5.1 Submenu COM Port

The system is connected via the serial RS232 interface with a 1:1 connecting ca-
ble to a PC. The configuration of the COM Port of the PC can be carried out under
Configuration → COM Port.

FIG. 9 RS232 PARAMETER OF THE COM PORT

As Port you select the interface of your PC which is connected to the MAGIC AE1
DAB.

Under Mode you can set the desired operating mode:

– 9600 Baud

– 19200 Baud

– 38400 Baud

– 57600 Baud

– 115200 Baud

All further parameters like Data Bits, Parity and Stop Bits cannot be config-
ured.
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5.5.2 Submenu MAGIC AE1 DAB

Via the submenu MAGIC AE1 DAB the system can be configured comfortably.
It is distinguished between Basic Settings, which do not have to be changed
during the operation and the actual Configuration for the current application. In
contrast to a configuration, the basic settings cannot be saved as Preset (see
CHAPTER 5.5.3).

5.5.2.1 Operation Settings

5.5.2.1.1 MPEG Parameter

Via the option MPEG Parameter all MPEG settings can be configured in depend-
ence of the bitrate.

FIG. 10 MPEG PARAMETERS

MPEG Parameter

All possible bitrates, modes and sampling frequencies you can see in TAB. 1,
Page 35.

• Max. Mono Bitrate: With this setting you can define the maximum bitrate for 
the Mono mode. If the X.21 clock reach this limit, the coding mode will be au-
tomatically set to Mono.

• Max. LSF Bitrate: With this setting you can define the maximum bitrate for 
LSF1 encoding. If the X.21 clock reach this limit, the internal encoder sampling 
frequency will be automatically set to LSF. Note that the bandwidth will be lim-
ited in this case to approximately 12-kHz. LSF is recommended only for lower 
bitrates.

• Mono Mode: This setting allows to configure the Mono mode. Three options 
are available:

– Mono L: Only the left channel of the audio input will be encoded

NOTICE All listed settings made under Operation Settings can be saved as Preset.

1 LSF= Low Sampling Frequency (24-kHz) instead of 48-kHz.
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– Mono R: Only the right channel of the audio input will be encoded

– Mono (L+R)/2: If you have connected a Stereo signal this setting allows 
the generation of a Mono signal.

• Stereo Mode: This option define the Stereo mode of the encoder. Three pos-
sibilities are available:

– Stereo: This mode is recommended for data rates from 192-kbit/s or 
higher.

– Joint Stereo: This mode offers more efficiency and best quality for 
stereo signals if the bitrate is 160-kbit/s or lower.

– Dual Channel: There are no audible differences between Stereo and 
Dual Channel mode. Only the multiplexing as well as the signalling in 
the ISO/MPEG header is different. Select this mode if you insert totally 
different signals on the left and the right channel.

NOTICE Note that the ISO/MPEG encoder will switch automatically to pure Stereo mode,
if the bitrate is adequate. This behaviour you can see on a decoder: An alternate
switching between Stereo and Joint Stereo can be recognised. Of course this
switching is a feature of the ISO/MPEG Layer II encoder and is not audible.

TAB. 1 POSSIBLE DATA RATES AND MODES

Bitrate

kbit/s
Possible Coding Mode

Possible Sampling Frequency

kHz

8 Mono 24

16 Mono 24

24 Mono 24

32 Mono 24, 48

40 Mono 24

48 Mono 24, 48

56 Mono 24, 48

64 All modes 24, 48

80 Mono 24, 48

96 All modes 24, 48

112 All modes 24, 48

128 All modes 24, 48

144 All modes 24

160 All modes 24, 48

192 All modes 48

224 Stereo, Joint Stereo, Dual channel 48

256 Stereo, Joint Stereo, Dual channel 48

320 Stereo, Joint Stereo, Dual channel 48

384 Stereo, Joint Stereo, Dual channel 48
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5.5.2.1.2 PAD Interface

Via the configuration PAD Interface you can enable the PAD1 Insertion from an
external PAD inserter. The standard settings are compliant to the synchronous
frame mode of the IRT Recommendation.

The data insertion works dynamically: If data are available the audio bitrate will
be reduced automatically according the PAD bitrate. Otherwise the full frame is
used for audio.

Maximum number of PAD bytes per frame depends on the baudrate:

38400 Baud 54 bytes/frame

57600 Baud 90 bytes/frame

115200 Baud 127 bytes/frame

FIG. 11 PAD INTERFACE

To enable the PAD transmission you must set the option Activate PAD. The
RS232 interface parameter Baudrate must be conform to the connected PAD in-
serter. Available baudrates are 38400, 57600, and 115200 Baud. The Parity and
Stop Bits cannot be changed. The standard settings are: 38400 Baud, Parity
None and 1 Stop Bit.

1 PAD = Program Associated Data
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5.5.2.2 Basic Settings

5.5.2.2.1 General

FIG. 12 GENERAL

Key Tone

• To activate the Key Tone of the front keypad, check the Enabled box.

Display

• The Display has a backlight. Under the setting Backlight you can switch it 
ON permanently. If you select the option Auto the backlight is turned off au-
tomatically 60 seconds after the last keystroke. The backlight is activated 
again by pressing any key (e.g. ).

• Via the slide control Contrast you can adjust the contrast in the range -16 ... 
15 for the display.

RS232 Interface

• If you want to operate the system with the PC, you must set under Mode the 
data rate in accordance with the interface of the system (see CHAPTER 5.5.1, 
Page 33). There are five baud rates available: 

– 9600, None

– 19200, None

– 38400, None

– 57600, None

NOTICE All configurations made under Basic Settings cannot be saved as Preset (see
CHAPTER 5.5.3).

NOTICE Please notice that if the keypad lock is activated, the backlight is only switched
on again by pressing the key sequence Menu * .
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– 115200, None

Program Name

• The entered Name of the program will be shown on the Program button (see 
Page 31) in the PC software main window as well as in the status line of the 
system display.
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5.5.2.2.2 Audio Interface

MAGIC AE1 DAB supports analogue as well as digital AES/EBU Audio interfaces.
If the digital interfaces are used, a separate Sample Rate Converter is available
for the input and the output so that external adjustments are not required if there
are different digital sources and drains.

FIG. 13 AUDIO INTERFACE

Audio Interface

• The operating mode analogue or digital can be set separately for the Audio 
Input and the Audio Output.

• If the output is set digital, additionally the configuration for the AES/EBU In-
terface is displayed. Under Clock Source of digital output you can select 
the following options:

– Internal: The AES/EBU output clock is derived from the internal system
clock.

– External: The AES/EBU output clock is derived by the external clock con-
nected via the interface Audio 2/CLK IN. The clock rate of the connected
clock must be 48-kHz.

– Recovered: The AES/EBU output clock is derived from the digital input sig-
nal of the interface Audio 1/AES IN. This configuration is usually to be se-
lected if you use the digital input of the system. In this way a synchronous
functioning of the transmission chain is ensured  

• If you operate the input or the output in an analogue mode, the corresponding 
slide control for adjusting the nominal Audio level of the Audio interface (Main 
Nominal Level) is displayed. The nominal level can be adjusted separately for 
the input (Level In) and for the output (Level Out) in the range of -3 ... +9 
dBu in 1-dB steps. The head room is 6 dB in general. If you want to have the 
maximum level of 15 dBu for the system, you must set 9 dBu as nominal level. 
The default settings are 0 dBu.

NOTICE The AES/EBU input always works with recovered clock, therefore a configuration
of the output is required.
For clock synchronisation to other systems you can use the Audio output Audio
2/CLK OUT. The clock rate of the output clock is 48-kHz.
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5.5.2.2.3 Relay / TTL 

The MAGIC AE1 DAB system incorporates six GPIO Pins (TTL) which can be pro-
grammed separately as input or output. Additionally, two Relays are available.

The operating mode of a TTL-Pin - Input or Output is selected via the option Di-
rection.

The following specification accounts for all three configuration windows TTL1 ...
TTL6.

TTL-Pin as input

FIG. 14 TTL-PIN AS INPUT

If you use a TTL-Pin as Input, you can program two different functions separately
when edges change:

• Positive edge: The event is activated when the voltage on the TTL-Pin 
changes from 0V to +5V.

• Negative edge: The event is activated when the voltage on the TTL-Pin 
changes from +5V to 0V.

The following functions can be configured (Function Code):

– -: No function, the negative edge is not used.

– Connect:
Via this function you can establish a connection.

– Connect (level triggered):
Same function as Connect, but the event is activated level triggered and
not edge triggered.

– Disconnect: If you activate this function, a connection can be discon-
nected.

– Load Preset: Via this function it is possible to load a preset which you
have to select under Preset.

– Information Base entry: Reserved for future applications.
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– String Command: Reserved for future applications.

Example:

You want to connect the X.21 line with TTL 1. After the transmission has 
been finished the connection is to be cleared with TTL 1.

Programming:

Positive egde:

Function Code: Disconnect

Negative egde:

Function Code: Connect

FIG. 15 SEQUENCE OF EVENTS FOR THE EXAMPLE

15-pol. SUB-D connector
to MAGIC AE1 DAB

(TTL/RELAY)

Switch is opened:
Pin 9 = TTL 1 is on +5 V (via internal 10 KOhm series resistance)

Switch is closed:
Pin 9 =TTL 1 is set to 0V (Pin 5):
Connection is established

Switch is opened:
Pin 9 =TTL 1 is set to +5V:
Line is disconnected

Switch

18

915
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TTL-Pin as Output

FIG. 16 TTL-PIN AS OUTPUT

If a TTL-Pin is configured as Output, the event is signalised as change of voltage
on the TTL-Pin from 0V to+5V.

Under Positive edge you can select one of the following Function Codes:

– Fixed to Low (0V): The TTL-Pin is set to 0V permanently.

– Fixed to High (5V): The TTL-Pin is set to +5V permanently.

– Connection State: Via Connection State you can signalise the connection 
state of a line. The following configurations are possible:

– Disconnect 

– Connect

– System Alarm Pending: If one of the possible system errors (see CHAPTER 
5.7.1) occurs, it can be signalised by selecting this option.

– MPEG Encoder running: If the encoder detect no error, the TTL-Pin will be 
set.

– PAD available: If the PAD insertion is activated (see CHAPTER 5.5.2.1.2, 
Page 36) and the encoder receives data the TTL-Pin will be set.

ATTENTION Please pay attention to the maximum switch current of 10 mA respectively the
maximum switch voltage of 5V per TTL output.

!
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Relay

The following description applies for both configuration windows Relay 1 and Re-
lay 2.

FIG. 17 RELAY 

The options for the relay configuration are identical with the configuration of a TTL-
Pin. The following Function Codes are available:

– Always Open: The relay is always open.

– Always Closed: The relay is always closed. This can be used for example for 
surveillance of the power supply.

– Connection State: Via Connection State you can signalise the connection 
state of a line. The following configurations are possible:

– Disconnect 

– Connect

– System Alarm Pending: If one of the possible system errors (see CHAPTER 
5.7.1) occurs, it can be signalised by selecting this option.

– MPEG Encoder running: If the encoder detect no error, the relay will be 
closed.

– PAD available: If the PAD insertion is activated (see CHAPTER 5.5.2.1.2, 
Page 36) and the encoder receives data the relay will be closed.

ATTENTION Please pay attention to the maximum switch current of 200 mA respectively the
maximum switch voltage of 48V per relay output.

!
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5.5.2.3 Login

To protect the system from re-configurations, two password levels with different
user rights are available. 

• Under USER you assign the user Password. For safety reasons you must 
confirm the password under Confirm Password.

• Under ADMINISTRATOR you assign the Administrator Password. For safety 
reasons you must confirm the password under Confirm Password.

FIG. 18 LOGIN

When you have assigned a password, the window for the password entry is auto-
matically displayed when you click on a menu with password protection. Please
enter the User Password or the Administrator Password.

FIG. 19 PASSWORD LOGIN

The authorisation levels are defined as follows:

(1) Only Administrator Password is configured: The password must be entered 
for configuration changes. Immediately available menus:

– File → Operation Settings Presets → Export

ATTENTION The entered password is saved in the system. It is highly important that you enter
your password carefully. If you have forgotten your password, only the AVT Service
can re-activate the system.

NOTICE There is no differentiation between upper and lower case for the password entry.

!
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– File → Basic Settings → Export

– Configuration → Presets → „Configuration Name“

– Administration → Registration

– Extras → System Monitor

– Help → About MAGIC AE1 DAB

(2) Only User Password is configured: The password must be entered always.
Afterwards all menus are available. Immediately available menus:

– Help → About MAGIC AE1 DAB

(3) User Password and Administrator Password are configured: The password
must always be entered.

User Password is entered:

Under Configuration → Configuration → Login the USER pass-
word can now be changed.

Via Configuration → Presets the desired configuration can be 
loaded.

Immediately available menus: 

– Extras → System Monitor

Administrator Password is entered: All menus are available.

NOTICE Please pay attention to the configuration options of the system if a password is
assigned (see CHAPTER A1).
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5.5.2.4 Date and Time

Via the panel Date and Time it is possible set the internal clock of the system.

To synchronise the System Time to the PC Time press the button Transmit PC
Time.

To setup another time e.g. for other time zones you can enter a User Defined
Time. To set the time in the system press the button Transmit User Defined
Time.

FIG. 20 DATE AND TIME
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5.5.3 Submenu Presets

Via Presets you can load already created configurations.

5.5.3.1 Manage Presets

Your created Presets can be managed via the menu Configuration → Presets
→ Manage Presets.

FIG. 21 MANAGE PRESETS

All already existing configurations are displayed in the list.

• With the use of the New button you create a new configuration. The current 
configuration of the system is not changed or loaded by this function. First, se-
lect an expedient name. The length of the name must not surpass 8 charac-
ters. Special characters and space characters are not allowed. Please mind 
that you use unique names.

Subsequently, the configuration dialogue is opened for the editing of the Pre-
sets. The current configuration is always displayed as basis of a Preset which 
you can adjust according to your wishes. The following configurations can be 
saved as Preset:

– MPEG Parameter (see Page 34)

– PAD Interface (see Page 36)

• By using the button Edit the currently selected configuration can be edited. 
The current configuration of the system is not changed or loaded with this 
function.

• Via the button Delete the configuration selected from the list is deleted. For 
safety reasons you have to confirm your selection.

• To activate a configuration selected from the list, press the Select button. For 
safety reasons you have to confirm your selection.

• Via the button Import a configuration can be imported from a data carrier 
(disk, USB stick etc.). The file extension of the configuration file is always ‘.pst‘. 
A click on the button opens the file browser in which the desired file can be se-
lected.
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• Likewise, it is possible to export configurations to a data carrier. The button 
Export saves the configuration selected from the list as ‘.pst‘ file. By clicking 
on the button the file browser is opened and you can choose the location 
where the file is saved.

With Export All all configurations displayed in the list are saved in a directory 
of your choice. A separate data file with the file extension ’.pst‘ is generated 
for each configuration.

5.5.3.2 Activation of a Preset

All Presets are displayed under Configuration → Presets → „Preset Name“
and can be activated with a click.

For safety reasons a confirmation is required.

TIP If you need to configure several systems in the same way, set up one system first
and export all configurations to a disk. To configure all further systems easily, im-
port the configurations from the disk.

This is also possible for the Basic Settings. Via the Import/Export function un-
der File (see CHAPTER 5.4) you can comfortably save all information and load on
other systems.
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5.6 Menu Administration

FIG. 22 MENU ADMINISTRATION

5.6.1 Submenu Registration

The data concerning production as well as the enabled options can be displayed
under the submenu Registration.

FIG. 23 SUBMENU REGISTRATION

The data of the unit include the following information:

– Hardware

– Subject Number

– Factory Number

– Year of production

– Hardware Version

• Under Features the available and activated Software Options of the MAGIC 
AE1 DAB are displayed. Deactivated options can be activated via a password. 
This password is assigned according to the Factory Number. If you bought an 
option supplementarily, please enter the password that you received from us 
under Enter Password.

This number
is required
to enable

software options
supplementarily
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FIG. 24 PASSWORD ENTRY TO ENABLE AN OPTION

Subsequently, the system executes a warm start. Afterwards, the functions are ac-
tivated.

ATTENTION Please enter the password carefully.

If you enter a wrong password three times, you must switch off the system and
switch it on again.!
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5.6.2 Submenu File System

Selecting the submenu File System the storage system (similar to a PC’s hard
drive) of the system is displayed.

FIG. 25 SUBMENU FILE SYSTEM

• The button Delete File deletes the currently selected file from the system.

• Via the button Copy PC -> Unit you can copy a file from the PC to the system.

• Via the button Copy Unit -> PC you can copy a file from the system to the PC.

ATTENTION Please do not use the File System unless our Service requested a specific action.

ATTENTION Please do not delete any file unless our Service requested a specific action. Oth-
erwise a disfunction of the system is possible.

ATTENTION Please use the Software Download and the File Import functionalities respec-
tively to copy files to the system.

ATTENTION Please use the File Export functionalities to copy files to the PC.

!

!

!

!



PAGE 52 

W i n d o w s  P C  S o f t w a r e

5.6.3 Submenu System Panel

The System Panel is only for service purposes. Please enter only commands in
the prompt, if our Support requested it from you.

FIG. 26 SUBMENU SYSTEM PANEL
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5.6.4 Submenu Software Download

The required firmware for the MAGIC AE1 DAB system is always included in the
PC software: Via the Software Download you can comfortably download the
firmware on your system.

By using the Browse button you select the firmware file. It is always located in the
same directory in which you installed the MAGIC AE1 DAB application. The stand-
ard installation directory is:

C:\Program Files\MAGIC AE1 DAB

The file name of the firmware is „ae1dab.ssw“.

FIG. 27 SUBMENU SOFTWARE DOWNLOAD

Please press the Start button to download the firmware. The Progress bar dis-
plays the progress of the download. The process is finished after about two min-
utes. If the download was successful, a corresponding message is displayed. After
your confirmation the system is reset.

NOTICE If the download was not successful, you can simply switch off the unit and switch
it on again. The new software is only written in the flash memory if the download
was successful. Otherwise the old firmware is maintained.
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5.6.5 Submenu Set Factory Settings

By using the submenu Set Factory Settings the system can be reset to the ini-
tial state.

For safety reasons you have to confirm your selection.
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5.7 Menu Extras

FIG. 28 MENU EXTRAS

5.7.1 Submenu System Monitor

Via the menu System Monitor you receive information about the system status.

FIG. 29 SUBMENU SYSTEM MONITOR

A red LED signalises a currently existing alarm. How often the error occurred since
switching on is displayed by the corresponding error counter.

To reset all error counter press the button Alarm Counter Reset.

• Under System alarms all potential system alarms are displayed:

– LCA: The communication with a programmable component is faulty.

– Time Keeper: The communication with the integrated clock module is
faulty.

– A/D D/A Converter 1: The communication with the first ADDA converter
is faulty.

– A/D D/A Converter 2: The communication with the second ADDA con-
verter is faulty.

– Temperature Sensor: The communication with the temperature sensor
is faulty.

– FLASH EPROM: The communication with the permanent memory is
faulty. Configurations cannot be saved or read anymore.

TIP A system alarm can also be configured as relay output (see Page 40).

NOTICE If an alarm occurs frequently or over a longer period disconnect the unit from
electricity. If the error occurs again after switching on, there is probably a hard-
ware defect.

Error Counter
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– MAIN EEPROM: The communication with the permanent memory is
faulty. Configurations cannot be saved or read anymore.

– Overheated: The system sets this alarm if the system temperature is
higher than 57°C. Disconnect the unit from electricity or cool down the am-
bient temperature.

– MPEG Encoder DSP error: This alarm occurs, if an error on the DSP
module is detected.

• Under Application alarms all ISO/MPEG alarms are centralised:

– Encoder running: If the encoder is not running, this alarm will be set.

– Decoder synced: For monitoring purposes the coded signal is decoded at
any time via the integrated ISO/MPEG decoder.

– X.21 clock: This alarm occurs, if the external X.21 line clock is not availa-
ble.

– X.21 clock valid: This alarm occurs, if the external X.21 line clock is not
locked to one of the available bitrates (see TAB. 1, Page 35)

– PAD: If PAD is activated, but no data are available at the PAD interface, this
alarm will be set.

– Encoder sampling clock: This alarm occurs if the hardware sampling
clock do not fit with the expected sampling clock of the encoder.

– Decoder sampling clock: This alarm occurs if the hardware sampling
clock do not fit with the expected sampling clock of the decoder.

• The AES/EBU status shows the current status of the AES/EBU input if the 
digital audio input is selected (see CHAPTER 5.5.2.2.2).

The actual system temperature is displayed in °C under System Temperature.
The regular system temperature ranges from 30...45°C.

Under DSP Load the load of the system is displayed. The usual load is about 55
to 65%.
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5.8 Menu Help

FIG. 30 MENU HELP

5.8.1 Submenu About MAGIC AE1 DAB

In the About MAGIC AE1 DAB dialogue you find the software versions of the
PC software (PC Version) and of the systems (Firmware Version). Besides, you
can find our contact details there.

FIG. 31 SUBMENU ABOUT MAGIC AE1 DAB
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A 1 M E N U  S T R U C T U R E

On the following pages you will find the complete menu structure if you select ENG-
LISH as menu language

From the main menu you reach the phone book directly via the softkey Names.
With the use of the softkey Menu you get to the configuration of the system.

The configuration menu is divided in five submenus:

– Basic Settings

– Operation Settings

– Presets

– Status information

– Login

If you use an Administrator and/or User Password, the display looks as it is de-
scribed below:

(1) Only Administrator Password configured: The password must be entered 
for changes to the basic settings and operation settings only. Immediately 
available menus:

– Presets

– Status information

– Login

(2) Only User Password configured (instead of Menu, Login is displayed): The
password must always be entered. Subsequently, all menus are available.

(3) User and Administrator Password configured (instead of Menu Login is dis-
played):

– User Password is entered: The menus Presets, Status information 
and Login are available

– Administrator Password is entered: All menus are available.

NOTICE Please note that depending on the selected operating mode some menu items
are not displayed.

NOTICE There is no differentiation between upper and lower case for the password entry.



PAGE 60 

M e n u  S t r u c t u r e

A1.1 Basic Settings

Status Information

Login

Presets

Operation Settings
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A1.2 Operation Settings

Status Information

Login

Presets
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A1.3 Presets

Status Information

Login
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A1.4 Status Information

Login
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A1.5 Login
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A 2 I N T E R F A C E S

The interfaces of the system are pictured in Fig. 32.

FIG. 32 REAR VIEW OF THE MAGIC AE1 DAB AUDIO ENCODER

All interfaces are described below.
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A2.1 Control and data interfaces

A2.1.1 DATA/CONTROL interface

The DATA/CONTROL interface is used for the configuration and operation of the
MAGIC AE1 DAB system via a PC.

To connect a PC you need a 1:1 connecting cable in which Pin 2 and Pin 3 are not
crossed. Furthermore, Pin 5 GND must be connected.

NOTICE Please note that the function of the Pins RXD and TXD - input or output - is deter-
mined by the interface type DCE or DTE. The pin assignment for Pin 2 is always
RXD and for Pin 3 it is always TXD.

TAB. 2 PIN ASSIGNMENT: DATA/CONTROL INTERFACE

Socket: SUB-D, 9-pole

Pin Signal Electrical characteristics

1 not used PC interface RS232:

Type (Pin 2, 3): DCEa

Level: V.24
Data rate: 115200 Baud
Range: max. 15 m
Protocol: programmable

a DCE = Data Communication Equipment: to connect a PC a 1:1 cable is required

2 RXDb PAD Receive Data

b ATTENTION: On this Pin the MAGIC AE1 DAB transmits data

3 TXDc PAD Transmit Data

c ATTENTION: On this Pin the MAGIC AE1 DAB receives data

4 not used

5 GND Earth

6 not used

7 not used

8 not used

9 not used

5 1

9 6
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A2.1.2 DATA/PAD interface

The DATA/PAD interface is used for the transmission of Program Associated Data
(PAD). The interface is realised compliant to IRT Recommendation1.

To connect a standard PAD inserter you need a 1:1 connecting cable in which Pin
2 and Pin 3 are not crossed. Furthermore, Pin 5 GND must be connected.

ATTENTION Please note that the maximum number of PAD bytes per frame is 127. In this case
a baudrate of 115200 Baud must be configured.

1 Synchronous transmission mode: In the beginning of each ISO/MPEG frame the encoder transmit a 
SYN character (0x16). To realise frame synchronous PAD insertion the connected PAD inserter must 
transmit all data inside of this frame.

NOTICE Please note that the function of the Pins RXD and TXD - input or output - is deter-
mined by the interface type DCE or DTE. The pin assignment for Pin 2 is always
RXD and for Pin 3 it is always TXD.

TAB. 3 PIN ASSIGNMENT: DATA/PAD INTERFACE

Socket: SUB-D, 9-pole

Pin Signal Electrical characteristics

1 not used PC interface RS232:

Type (Pin 2, 3): DCEa

Level: V.24
Data rate: 115200 Baud
Range: max. 15 m
Protocol: programmable

a DCE = Data Communication Equipment: to connect a PC a 1:1 cable is required

2 RXDb PAD Receive Data

b ATTENTION: On this Pin the MAGIC AE1 DAB transmits data

3 TXDc PAD Transmit Data

c ATTENTION: On this Pin the MAGIC AE1 DAB receives data

4 not used

5 GND Earth

6 not used

7 not used

8 not used

9 not used

!

5 1

9 6
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A2.2 ISDN interface

A2.3 LAN interface

The LAN interface can be used for control and monitoring purposes.

NOTICE This interface is not supported in the MAGIC AE1 DAB system.

TAB. 4 PIN ASSIGNMENT: S0 INTERFACE (ISDN)

Socket: Western (8-pole) RJ45

Pin Signal Electrical characteristics

1 not used Recommendation: I.430
Data rate: B channel: 2 x 64-kbit/s

D channel: 16-kbit/s
Max. cable length: 100 m

2 not used

3 TX (A) Data out (A)

4 RX (A) Data in (A)

5 RX (B) Data in (B)

6 TX (B) Data out (B)

7 not used

8 not used

NOTICE The implementation of the LAN interface is planned for a later release.

TAB. 5 PIN ASSIGNMENT: S0 INTERFACE (ISDN)

Socket: Western (8-pole) RJ45

Pin Signal Electrical characteristics

1 TX (A) Data out (A) Standard Ethernet /10Base-T (IEEE-802.3)
Speed: 10 MBit/s
Cable type: Twisted Pair (CAT3)
Max. cable length: 100 m

Fast Ethernet /100Base-T (IEEE-802.3u)
Speed: 100 MBit/s
Cable type: Twisted Pair (min. CAT5)
Max. cable length: 100 m

2 TX (B) Data out (B)

3 RX (A) Data in (A)

4 not used

5 not used

6 RX (B) Data in (B)

7 not used

8 not used

1 8

1 8
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A2.4 X.21 interface

The X.21 interface is realised as DCE (Data Communications Equipment) inter-
face. The MAGIC AE1 DAB can be connected via an X.21 cable (part of the deliv-
ery) directly to the Ensemble Multiplexer (e.g. DM-001 from Rohde & Schwarz).

TAB. 6 PIN ASSIGNMENT: X.21 INTERFACE

Connector: 15-pole SUB-D

Pin Signal Direction Electrical characteristics

1 SHIELD Screen Type: DCE with Gender
Changer

Level: V.11, balanced

Data rates: 8, 16, 24, 32, 40,
48, 56, 64, 80, 
96, 112, 128, 
144,160, 192,
224,256, 320,
384-kbit/s

Range: 100 m

2 TX (A) Transmit Data (A) In

3 CTL (A) Control (A) In

4 RX (A) Receive Data (A) Out

5 IND (A) Indicate (A) Out

6 SCLK (A) Signal Element Timing (A) Out

7 BCLK (A)a Byte Timing (A)

a Normally not used

Out

8 GND Ground

9 TX (B) Transmit Data (B) In

10 CTL (B) Control (B) In

11 RX (B) Receive Data (B) Out

12 IND (B) Indicate (B) Out

13 SCLK (B) Signal Element Timing (B) Out

14 BCLK (B)a Byte Timing (B) Out

15 not used

81

159
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A2.5 TTL/RELAY interface

Via this interface external control signals can be used. The programming of the
available functions is possible via the Windows PC Software.

TAB. 7 PIN ASSIGNMENT: TTL/RELAY INTERFACE

Socket: 15-pole SUB-D

Pin Signal Direction Electrical characteristics

1 not used Specification of the TTL outputs:
Maximum voltage: 5V
Maximum current: 10mA

Specification of the relays:
Maximum voltage: 48V
Maximum current: 200mA

2 not used

3 not used

4 not used

5 GND

6 RELAY 1 (A) Out

7 RELAY 1 (B) Out

8 RELAY 2 (A) Out

9 TTL1 In/Out

10 TTL2 In/Out

11 TTL3 In/Out

12 TTL4 In/Out

13 TTL5 In/Out

14 TTL6 In/Out

15 RELAY 2 (B) Out

18

915



PAGE 71

I n t e r f a c e s

A2.6 Audio interfaces

The system incorporates analogue and digital AES/EBU audio interfaces. For
switching you can use display and keypad or the Windows PC software. The output
interfaces can be used for monitoring purposes.

A2.6.1 Analogue Audio interface

A2.6.2 Digital AES/EBU Audio interface

The MAGIC AE1 DAB system incorporates a digital AES/EBU input and output. The
input as well as the output has its own sample rate converter providing that a dig-
ital source with 32, 44.1 or 48-kHz can be connected directly. For external clock-
ing (48-kHz only) the word clock input or output may be used.

TAB. 8 PIN ASSIGNMENT: ANALOGUE INPUT (AUDIO 1/2 IN)

Socket: 3-pole XLR

Pin Signal Electrical characteristics

1 GND Input level: adjustable -3 .... +9 dBu

Impedance: > 25 kΩ

Head room: 6 dB

2 AUDIO IN (A)

3 AUDIO IN (B)

TAB. 9 PIN ASSIGNMENT: ANALOGUE OUTPUT (AUDIO 1/2 OUT)

Connector: 3-pole XLR

Pin Signal Electrical characteristics

1 GND Output level: adjustable -3 .... +9 dBu

Impedance: < 50 Ω

Head room: 6 dB

2 AUDIO OUT (A)

3 AUDIO OUT (B)

TAB. 10 PIN ASSIGNMENT: DIGITAL INPUT (AES IN)

Socket: 3-pole XLR

Pin Signal Electrical characteristics

1 GND IEC-958

2 AUDIO IN (A)

3 AUDIO IN (B)

TAB. 11 PIN ASSIGNMENT: DIGITAL OUTPUT (AES OUT)

Connector: 3-pole XLR

Pin Signal Electrical characteristics

1 GND IEC-958

2 AUDIO OUT (A)

3 AUDIO OUT (B)

Push

12

3

21

3

Push

12

3

21

3
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A2.6.2.1 Digital AES/EBU Clock interface

A2.6.3 HEADSET/MIC interface

This interface allows a monitoring of the decoded audio signal as well as the audio
inputs.

TAB. 12 PIN ASSIGNMENT: CLOCK INPUT (CLK IN)

Socket: 3-pole XLR

Pin Signal Electrical characteristics

1 GND TTL

2 CLOCK IN

3 not used

TAB. 13 PIN ASSIGNMENT: CLOCK OUTPUT (CLK OUT)

Connector: 3-pole XLR

Pin Signal Electrical characteristics

1 GND TTL

2 CLOCK OUT

3 not used

NOTICE The microphone input is not available in this system.

TAB. 14 PIN ASSIGNMENT: HEADSET/MICRO AUDIO INTERFACE

Socket: 5-pole XLR

Pin Signal Electrical characteristics

1 not used Output Power: 0,15 W
Load (Min.): 8 Ω
THD+N@1kHz: 0,25% (half power)
PSRRa: 83 dB
Level adjustment: 0 ... -40 dB

a PSRR: Power Supply Rejection Ratio

2 not used

3 GND

4 HEADPHONE left channel

5 HEADPHONE right channel

Push

12

3

21

3

Push

15

3 24
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A 3 T E C H N I C A L  D A T A

Coding Algorithm

ISO/MPEG Layer II (IRT Licence)
DAB EN 300401

Sampling Frequencies:

24-kHz, 48-kHz

Data Rates:

8, 16, 24, 32, 40, 48, 56, 64, 80, 96, 112-kbit/s
128, 144, 160, 192, 224, 256, 320, 384-kbit/s

Audio Interface Encoder:

XLR, analogue, electronically balanced
digital AES/EBU with integrated Sample Rate Converter

Audio Level:

-3 ... +9 dBu

Headroom:

6 dB (maximum level: 15 dBu)

Impedance:

600 Ohm/15 KOhm

THD+N:

~86 dB

Linearity:

± 0,3 dB
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Monitoring Output:

XLR, analogue, electronically balanced
digital AES/EBU with integrated Sample Rate Converter
Headphones output

Line Interfaces:

X.211

Data Interfaces:

PAD V.24/RS232 IRT Rec. compliant
38400, 57600, 115200 Baud
max. 127 bytes per frame @ 115200 Baud

Control Interface:

LAN2

PC V.24/RS232
GPIO 6 x TTL programmable

2 x Relays, programmable

Power Supply:

90...253V AC

Frequency:

50/60 Hz

Power Consumption:

typical 12W, max. 15W

Dimensions (H x W x D):

45 (1U) x 451 x 250 mm
with brackets system fits into a 19“ rack

1 ISDN interface is not in use

2 planned for a later release
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A 4 G E N E R A L

A4.1 Ordering numbers

MAGIC AE1 DAB 800401

Accessories

-

Software Options

-

A4.2 Scope of delivery

– MAGIC AE1 DAB

– CD MAGIC AE1 DAB Updates (ID: 430283)

– Mains power supply cable

– RS232 cable

– X.21 interface cable 15-pole SUB-D, 2 x Socket

– 19’’ Mounting Brackets

– Manual

A4.3 Declaration of Conformity

You will find the declaration of conformity at the end of this manual.
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S e r v i c e  I n f o r m a t i o n

A 5 S E R V I C E  I N F O R M A T I O N

A5.1 Software Updates

Free Software Updates you will find on our Homepage under

http://www.avt-nbg.de

Ident No.: 430282

A5.2 Support

You can contact our Support via email or by telephone:

support@avt-nbg.de

+49 911 5271-160 (09:00h - 17:00h)

To deal with your problem efficiently please note the factory number of the unit as
well as the software version that you use.

A5.3 Repairs

If, contrary to expectations, your unit is defective please fill in the attached status
report and send the unit to the following address:

AVT Audio Video Technologies GmbH
- Repairs -
Nordostpark 12
D-90411 Nuernberg
Germany
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I N D E X

Symbols

.pst 47, 48

Numerics

1 U 15
115200 25, 33
19 " 19
19" rack 15
19-inch-rack 19
38400 25
57600 25, 33
9600 33

A

A/D D/A Converter 1 55
A/D D/A Converter 2 55
About MAGIC AE1 DAB 57
Accessories 75
Activate PAD 25, 36
Active 25
Administrator 44, 59
ae1dab.ssw 53
AES/EBU 24, 56, 71
AES/EBU Interface 39
AES/EBU status 56
Air humidity 19
Alarm 55
Alarm Counter Reset 55
Ambient temperature 19
Analogue 24, 25, 39
Audio 1/AES IN 39
Audio 2/CLK IN 39
Audio 2/CLK OUT 39
Audio Input 39
Audio input 24, 25
Audio interface 24
Audio Output 39
Audio output 24, 25
Audio settings 24, 25
Auto 37

B

Backlight 37
Basic configurations 23
Basic Settings 37
Baudrate 25

Browse 53

C

character 47
Clock 39
Clock Source of digital output 39
COM Port 33
COM-Port 29
Configuration 29, 33, 34, 44, 47,

59
Confirm Password 44
Connect 42, 43
Connecting cable 66, 67
Connection Status 42, 43
contact information 57
Contrast 37
Conventions 14

D

Data Bits 33
Date/Time 27
Deactivation 23
Declaration of Conformity 75, 83
Decoder not synced 56
Decoder running 56
Decoder sampling clock 56
Delete 47
Delete Preset 27
Desktop device 19
Digital 24, 39
Direction 40
Disconnect 42, 43
Display 20, 37, 71
Display illumination 23
Download 53
Dropping 26
DSP Load 56
DTE 66, 67
Dual Channel 25, 35

E

Earthing 19
Earthing screw 19
edge change 40
Edit 47
Email 77
EMC 19
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I n d e x

Enabled 37
Encoder running 56
Encoder sampling clock 56
English 59
Enter Password 49
error counter 55
Exit 32
Export 32, 48
Export All 48
External 39
External Power Supply 30
Extras 45

F

Factory Number 49
Factory Settings 54
Features 49
Firmware 53
Firmware Version 57
Fixed to High (5V) 42, 43
FLASH EPROM 55
Flash memory 53
Front view 15, 30
Function Code 40, 42, 43
Functional elements 17

G

GPIO 40

H

Hardware error 55
Hardware requirements 29
Hardware Version 49
Headphone 31
Headroom 19, 71
Homepage 77
Hotline 77

I

Import 32, 47, 48
Input 31, 40
Install Software 29
Installation 29
Interface 65
Internal 39
IRT 36

J

Joint Stereo 25, 35

K

Key Tone 37

Keypad 71
Keypad (9600 Baud) 37
keypad lock 37

L

LCA 55
Level In 39
Level Out 39
Load 27
Load Preset 40
Login 45, 59
LSF 34

M

MAGIC AE1 DAB Software 23
MAIN EEPROM 56
Main menu 23, 26, 59
Mains voltage 19
Manage Presets 47
Max LSF Rate 24
Max Mono Rate 24
Max. LSF Bitrate 34
Max. Mono Bitrate 34
Menu 37, 59
Menu structure 23, 59
Minimum requirements 29
Monitoring 31
Mono (L+R)/2 35
Mono L 34
Mono L+R/2 25
Mono Left 25
Mono Mode 25
Mono R 35
Mono Right 25
Mounting brackets 19
MPEG Parameter 24, 25

N

Names 59
Navigation 20
Negative edge 40
New 27, 47
NO CONNECTION 30

O

On 37
ON AIR Nominal Level 39
Operating buttons 20
Operation 13
Operation settings 59
Operation Settings Presets 32
Operational elements 20
Options 49
Ordering numbers 75
Output 31, 40, 42
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Overheated 56

P

PAD 36
PAD Interface 25
Parity 33
Password 44, 49, 59
PC 66
PC (19200 Baud) 33, 37
PC (38400 Baud) 33
PC Offline 30
PC ONLINE 30
PC Online 30
PC ONLINE ALARM 30
PC Software 71
PC Version 57
Phone book 59
Port 33
Positive edge 40, 42
POTS 66
POTS interface 66
Power consumption 19
Preset 27, 34, 37, 40
Preset menu 27
Presets 27, 45, 47, 59
Program 31
Program Name 31
Progress 53
Putting the system into operation

27

Q

QuickMenu 23

R

Rack 19
Recovered 39
Registration 49
Relay 70
Relay 1 43
Relay 2 43
Relay output 43
Relays 40
Repairs 77
Resolution 20
RS232 33

S

S0 interface 68
Safety instructions 13
Sample Rate Converter 24, 39,

71
Save 27
Scope of delivery 75
Select 47

Serial cable 29
Service 52
Set Audio Line 40
Setup 29
setup.exe 29
Softkey 20
Software 23, 77
Software Download 53
Software Options 49
Software Updates 77
Software Versions 57
space 47
Standby mode 19
Start 53
Status 42, 43
Status information 59
Stereo 25, 35
Stereo Mode 25
Stop Bits 33
Storage 13
Subject Number 49
Support 52, 77
switch current 42
switch voltage 42
synchronous 39
System Alarm 42, 43
System alarm 55
System alarms 55
System Monitor 30, 45, 55
System Panel 52
System settings 24, 25, 59
System Temperature 56
System temperature 19

T

temperature 56
Temperature Sensor 55
Threshold values 19
Time Keeper 55
Transmission clock 24
Transport 13
TTL 40, 42, 43, 70
TTL1 40
TTL2 40
TTL3 40

U

Updates 77
USB Stick 47
User 44, 59
User Rights 44

V

Ventilation 19
Version 57
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W

Warm start 50
Warranty claim 19

X

X.21 clock 34, 56

Y

Year 49



Supplier’s name: AVT Audio Video Technologies GmbH

Supplier’s address: Nordostpark 12
D-90411 Nuernberg
Germany

declares, that the product

Product name(s): MAGIC AE1 DAB

conforms to the standards of the following European directives:

Number/title: EN 60950 A4 Safety

The conformity is evidenced by strictly meeting the following standards:

Harmonized Standards: EN 55022, EN 55024,
EN 300386,
FCC Part 15 B

Place, date: Nuernberg, 20.06.2006

 
Name: Wilfried HECHT (Managing Director)

Legally binding signatures:  

 
Phone: +49 911 5271-0

This declaration includes no warranty of properties.

The safety instructions specified in the product documentation delivered must be observed.
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DECLARATION OF CONFORMITY
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